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Installation

Windows Installation

This CD contains a Master Installer program that provides an easy and convenient way to
install the programs on the CD.  Follow these instructions to use the Master Installer.

1) Insert the program CD into the CD-ROM drive.
2) From the Windows Program Manager,  click once in the File menu option to

display the File menu and select Run.
3) In the Run dialog box, type D:\INSTLL.EXE (note the spelling, no “A”), and

press Enter.  If your CD-ROM drive letter is not D, substitute accordingly.
4) The Master Installer main screen is displayed and you are presented with a list

of products to choose from.  Make your selections from the list and click on
Install to continue.  Master Installer will launch the individual installers  for
each of the products selected, and return to the Master Installer screen.  Follow
the on-screen instructions to complete the installation for each program.  Please
note that some installations may restart your Windows session.
If you encounter problems installing several programs at once, quit the Master
Installer program, and restart it.  Install one program at a time.

Macintosh Installation

Design It! 3-D™ is compacted with a self-running installer. If you are familiar with basic
Macintosh operating procedures, you are ready to install Design It! 3-D by following these
steps:

1 Insert the CD-ROM into the CD drive and double-click on the disk icon.
2 Double-click on the Design It! 3-D disk icon to open it and double-click on the

Installer icon.
3 Click on the Continue button and select the installation options in the dialog box.

The default installation is the Design It! 3-D application, and all Galleries and
Models (Scenes).

4 When all the installation options have been selected, click on the Install button, the
program is extracted onto the user's hard disk.

5 After the program has extracted, double-click on the Design It! 3-D icon to start
the program.

To begin using Design It! 3-D right away, read the Creating 3-D Models chapter.



Introduction

Design It! 3-D is a unique 3-D modeling program that features a “drag-and-drop”
approach to creating your own worlds. You don’t have to build anything from scratch;
to construct complex objects and structures, just drag basic 3-D shapes from the
program’s object galleries and drop them into a 2-D design window. You may edit an
object’s shape, size and color;  and surface features (windows and doors, for example),
and combine the object with other objects.  Any addition or change is rendered in a
companion 3-D walk window where you can roam through and explore your model by
navigating with your mouse.

The program features one cubic mile of “cyberspace” in which designs may be created.
Also included are numerous galleries of 2-D surface features and textures, and 3-D
objects that can be added to your Design It! 3-D worlds. Additionally, pre-built scenes
that illustrate the program’s modeling, texture mapping and real-time “walk through”
capabilities are provided.

Macintosh and Windows Documentation

Design It! 3-D should be successfully installed on your computer before you begin
modeling. If you have installation questions, please refer to the  Installation information
on the following two pages.

This document is designed for  both Macintosh and Windows users with basic operating
knowledge of one platform or the other. Most of the features of Design It! 3-D are
identical in both the Macintosh and Windows versions.

Macintosh Installation

Design It! 3-D™ is compacted with a self-running installer. If you are familiar with basic
Macintosh operating procedures, you are ready to install Design It! 3-D by following
these steps:

1 Insert the CD-ROM into the CD drive and double-click on the disk icon.
2 Double-click on the Design It! 3-D disk icon to open it and double-click

on the Installer icon.
3 Click on the Continue button and select the installation options in the

dialog box. The default installation is the Design It! 3-D application, and
all Galleries and Models (Scenes).

4 When all the installation options have been selected, click on the Install
button, the program is extracted onto the user's hard disk.



The Macintosh Installation dialog box

5 After the program has extracted, double-click on the Design It! 3-D icon
to start the program.

To begin using Design It! 3-D right away, read the Creating 3-D Models chapter.

Windows Installation

If Windows version 3.1 or later is successfully installed on your computer and you
are familiar with basic Windows functions and features, your Design It! 3-D™

application is ready to install by following these steps:

Please follow  the instructions in the front of this document entitled

"Installing the Programs from the CD"

The Welcome dialog



To begin using Design It! 3-D right away, read the Creating 3-D Models chapter and
work through the Tutorial chapter in this  guide.

Contacting Technical Support

With your registration of this product you are entitled to technical support and to recieve
the SoftKey Catalog enabling you to purchase other SoftKey products at a discounted
price.

Simply call 1-800-845-8692 to register.

If you have questions about the program, consult this manual and the program’s on-line
Help system. If you’re still experiencing difficulty, gather the following information:

• The name and version of the program you have a question about.
• Amount of RAM in your system.
• A description of your problem, including any error messages.
• A list of the steps required to replicate the problem.

Technical Support may be contacted at:

(770) 428-0008
9:00 am to 8:00 pm Monday through Friday
(Eastern Standard Time)

Send correspondence to:

SoftKey International Technical Support
450 Franklin Road
Suite 100
Marietta, GA 30067

Send FAXES to:

ATTN: Technical Support
(770) 427-1150



Overview

Document Windows

There are three windows in Design It! 3-D: Gallery Window, Walk View Window
and Design View Window. Below are descriptions of these windows and a discussion
of their functions.

Gallery Window

The Gallery Window displays the 3-D library objects that you drag and drop to create
your virtual environment. The gallery of objects can be changed by clicking the title
button near the top of the window and selecting another gallery name.

Design View

The Design View Window is the 2-D plane where you drag and drop the Gallery
Objects.  Also you can resize and texturize the objects to get the desired view in the 3-
D Walk View Window.

Walk View

The Walk View Window is where you see and interact with the 3-D virtual environment
that you create. Gallery objects that you drag and drop into the Design View are
displayed in 3-D in the Walk View. You can navigate in, around or through these
objects using the navigation buttons or the mouse cursor.

Message Bar

A Message Bar is displayed at the bottom of your computer screen. Within the Message
Bar, you will see information associated with the operations that you perform. For
example, if you select a particular tool in the Tool Bar, the Message Bar will display
the tool’s purpose and how the tool is used.

Memory Indicator

There is a memory indicator to the right of the Message Bar, at the lower right corner
of your screen. It contains a colored bar that alternately shrinks and grows, displaying
the amount of memory currently used by Design It! 3-D. If the memory used  is below
75%, the bar is blue; if not, it is red.

NOTE: Macintosh users, if you are running low on memory, try quitting the
application and allocating more RAM to Design It! 3-D.



Active Window

The Active Window is the window in which you are  working.  At any time either the
Design View is active or the Walk View is active. The Walk View is available by
choosing Walk from the Window menu or clicking the Change View button.  To get
back to the Design view click the Change View button again or select Design from the
Window menu.

Tool bar

The Tool bar

Within the Design View is the Tool bar. The Tool bar displays the tools that you use
to edit objects and object surfaces as well as buttons that can be used to change the
Design View perspective.

View Selector Buttons

T is the Top View, F is the Front View and R is the Right View. Clicking one of these
buttons changes the Design View perspective.

  Surface Editor Tool

The Surface Editor Tool opens the Surface Editor, which allows you to edit a selected
surface. A surface is a single side or face of an object.

Select Object Tool

The Select Object Tool is used to select objects to be edited.  With the Select Object
Tool, you point to an object and click on it to select it. A selected object displays handles
at its vertices. A vertex is where two object surfaces, or faces, meet.

Magnify Tool

The Magnify Tool increases the apparent scale of the Design View or Zooms In on an
object. If you select the Magnify Tool by clicking it once, then point to the area that you
wish to zoom toward and click, the apparent scale of the Design View will double.



Zoom-Out Tool

The Zoom-Out Tool decreases the apparent scale  of the Design View. If you select
the Zoom-Out Tool by clicking on it once, then point to the area that you wish to zoom
away from and click, the apparent scale of the Design View will decrease by a factor
of two.

Resize Object Tool

The Resize Object Tool resizes an object about its center or about a specified anchor
point. Objects can be resized uniformly along all three axes or non-uniformly along a
single axis.

Change View Button

The Change View Button toggles you back and forth between the Design View and
Walk View.

Rotate Object Tool

The Rotate Object Tool is used to rotate an object. This tool works in Top, Front and
Right Design Views, allowing rotation on more than one axis.

Color Palette Button

The Color Bar allows new colors to be selected, created and assigned to objects.

3-D Movement

Movement in the Walk View is accomplished by using the standard Design It! 3-D
navigation cursor techniques or the Navigation buttons along the top of the Walk View
Appendix A provides more detail on the different navigation modes.

Standard Design It! 3-D Navigation Movement through the Walk View is a response
to your movement of the mouse pointer relative to the cross hair in the center of the Walk
View screen.

Press the mouse button to begin movement and release the mouse button to stop.

The farther away from the cross hair that the cursor is positioned, the faster the walk
speed will be.



Direction is determined by the position of the pointer relative to the cross hair.

By using a combination of the Shift key plus the Option key (Macintosh) or the Ctrl
key (Windows) with the mouse, movements like tilting your head, sliding from side to
side, or increasing and decreasing your altitude are also possible.

Navigation Buttons

The Navigation buttons are only available in the Walk View. By pointing to a
Navigation button and clicking, you will move in a direction according to the button’s
function. If you hold down the mouse button while pointing to a Navigation button, you
will move continuously. From left to right along the top of the Walk View, the
Navigation buttons are: Move Forward, Move Backward, Turn Left, Turn Right, Move
Up, Move Down and Home.  When the Home Button is clicked, your position in the
virtual environment is returned to the 0,0,5.25 ft. coordinate (about eye level).  If you
tilted the view, using the Shift key, you may level your view by pressing the level
observer button.

The Navigation buttons

Walk Mode Buttons

The Walk Mode buttons are displayed to the left of the Navigation buttons along the
top of the Walk View. The Walk Mode buttons determine what happens when you click
with the mouse cursor in the Walk View.

The Walk Mode buttons from left to right are Walk, Select Surface and Select Object.
Only one Walk Mode button can be selected at any time.

Walk button

When the Walk button is depressed, you can move freely around the Design It! 3-D
world using either the Walk Mode Navigation buttons or the standard Design It! 3-
D mouse navigation techniques.

NOTE: If you use either the Select Surface button or the Select Object button, you
must then select the Walk button again before navigation (walking) is enabled.



3-D Surface Selector button

The 3-D Surface Selector button allows you to quickly access a surface in the Walk
View to edit; you can change the surface’s color or texture, or add surface features such
as doors, windows or a painting on the wall.

3-D Object Selector button

The 3-D Select Object button allows you to select an object in the 3-D Walk View and
have it become highlighted and centered so that you can edit it in the 2-D Design View.
This is extremely useful when you are working on a complex drawing and cannot select
the correct object in the Design View because another object is blocking it. (Another
way around this is to change views to the Front View or Right View, select the object,
then return to the Top View to move or edit the object.)

Record and Playback Buttons

These buttons are to record a new walk path, play that walk path, and stop it whenever
desired.  One thing you should keep in mind is that when you press the stop button
during your play session and then press the play button again it will play that walk path
from the beginning.  Also if you press the record button twice it will remove the old path
from memory.

Observer

The Observer represents your location in the virtual environment. The Observer is
represented by a circle with a line. You can move the Observer in the Design View by
clicking on it and dragging it with the screen cursor.  Also, you may adjust the direction
of view of the Observer by holding down the Option key (Macintosh) or the Control
key (Windows) then pointing to the center of the Observer and dragging in the desired
direction.



Design Concepts

Containment

Every object in Design It! 3-D knows what objects it contains and what object contains
it. Containment provides some important benefits. For example, if you move a
container, all objects contained within it also move and retain their orientation to each
other.

In Design It! 3-D, containment is an all-or-none state; an object is either fully contained
within another object or it is distinct from other objects. Objects cannot overlap (but
they can be joined at a common surface). It is possible to draw overlapping objects and
the program does not warn you if you do this; however, the result of overlapping objects
is that three-dimensional objects may appear twisted and grotesque when rendered in
the Walk View.

If you drag a small object into a larger object, a state of containment will exist when the
mouse pointer reaches the interior of the large object. The program indicates containment
by displaying small blocks called containment markers at the vertices of the containing
object. These markers will disappear when you release the mouse button.

Auto Connection

Design It! 3-D uses auto connection. Auto connection makes the adjacent surfaces of
objects that you have placed against each other share the same surface attributes. For
example, if you drag two objects (rooms) toward each other, the auto connection feature
will attach the two parallel surfaces when they touch. Any surface feature or surface
attribute can be shared between adjacent surfaces with the auto connection capability
of Design It! 3-D.

Placement Depth

When you drag and drop an object into the Design View, it automatically drops to 0 ft.
in the dimension that you cannot see. For example, if you drop an object in the Top
View, you can position it anywhere in the Top View by dragging. But change it to the
Front View and you will see that the object is at 0 ft. If you wanted the object to be 10
ft. off of the ground, change views to the Front View and manually drag the object up
to 10 ft., using the Select Object Tool. This method is used to stack objects on top of
each other (i.e. a lamp on a desk, a roof on a building). Because the Design View is two
dimensional, it will be necessary at times to change views to position objects as desired.



Creating 3-D Models

Opening a New File

To open a new file in Design Center, choose New under the File menu. If you wish to
open an existing model, choose Open under the File menu and use the standard
Macintosh or Windows Open dialog to select the Design Center file that you wish to
open.

Selecting New Galleries

If you click on the Gallery Window bar, a pop-up list of the Design Center object
galleries which are available in your main Design Center folder/directory will be
displayed. To open a new gallery, highlight the desired gallery name and select it with
the mouse.



Selecting a Gallery Object

To create a virtual environment in Design Center, it is necessary to first select objects
to add to your world. Point to an object in the Gallery Window, click to select it.

Drag and Drop

To move the selected gallery object to the Design View, drag it with the mouse cursor
from the Gallery Window to the Design View. Position the object and release the mouse
button. A 2-D object outline appears in the Design View at the point where the mouse
button was released.

Modifying an Object

Once an object has been dropped into the Design View, you may move it by dragging
it with the mouse cursor. You may also edit the object's color, scale, rotation and surface
opacity with the following tools and procedures.

Selecting an Object

Before editing an object, you must first select it. A selected object displays handles at
its vertices. You may select an object in the Design View or in the Walk View.

Selecting an object in the Design View

• Click the Select Object Tool in the Tool Bar, point to the object that you
wish to select and click.

Selecting an object in the Walk View

• Click on the Select Object button in the Tool Bar at the top of the Walk
View.  Point to the object in the Walk View that you wish to select, then
click. The object will appear in the center of the Design View and will be
selected.

 Select Object Tool

In addition to selecting objects, the Select Object Tool is also used to reshape objects.
If you point with the Select Object Tool to an object handle and drag the handle, you
can reshape the object.



If an object is grouped, the Select Object Tool cannot be used to reshape the grouped
object. The grouped object must be ungrouped (with the Ungroup command under the
Edit Menu) before the Select Object Tool can reshape it or its pieces.

Depending on what dimension you are viewing from, in the Design View (Top, Front
or Right), the reshaping capability of the Select Object Tool may be limited. Object
handles indicate to what extent an object can be reshaped. The illustrations show the
different appearances of handles and what those differences mean.

The three types of object handles

When dragging a handle, a regular object maintains its type. For example, if you drag
the handle of a rectangular object, the object remains rectangular. If you drag a handle
of an 8-sided polygon, the object remains an 8-sided polygon. This is true for regular-
shaped objects; however, irregular-shaped object handles move individually.

If you hold down the Option (Macintosh) or Ctrl (Windows) while you drag a handle
of a regular-shaped object, the object becomes irregular.

Reshaping an object

In addition to dragging a handle, you may also drag the line between two handles,
depending on the type of handles. Hollow handles limit the Select Object Tool’s
modifying capability, and gray handles indicate a grouped object.

Reshaping an object



Resize Object Tool

The Resize Object Tool scales or resizes an object about its center or about a specified
anchor point.

Objects may be resized independently along any of the three coordinate axes (dimensions).
Objects may also be resized uniformly in all dimensions (X, Y and Z) by holding down
Shift before dragging.

When an object is resized, its contents and any surface features are resized with it. If this
effect is undesirable, you may wish to use the Select Object Tool to resize or reshape
the object.

Resizing an object about its center

• Select the object to be scaled, select the Resize Object Tool, point to a
reference point (such as a corner) and drag to the new position.

Resizing About an Object Center

Resizing an object about a specified anchor point

• Select the object, select the Resize Object Tool and point to the desired
location of the anchor point. Hold down the Option key (Macintosh) or
Control key (Windows) and click to establish the new anchor point. Point
to a reference point and drag to a new location.

Resizing About a specified Anchor point

If you resize an object then add a surface feature to it, the surface feature will
automatically resize to the match the new scale of the object.



Rotate Object Tool

The Rotate Object Tool is used to rotate an object. When rotating an object, this tool
works in any view (Top, Front, Right), thus allowing rotation on more than one axis.

Rotating an object

• Select the object that you want to rotate, click on the Rotate Object Tool
and point to any location in the Design View to establish the center of
rotation. Drag the pointer away from the center of rotation. A dotted line
will appear between the pointer and the center of rotation.

Rotating an object

As you drag the pointer farther from the center of rotation, you gain finer control over
the angle of rotation. Drag the pointer in an arc around the center point to rotate the
object.

If Snap to Grid is selected (see Preferences) when you rotate the object or surface
feature, the rotation snaps to 5° increments.

If you hold down Shift when you rotate the object, the rotation is constrained to 15°
increments.

Contained objects are rotated with the container unless you hold down the Option key
(Macintosh) or Control key (Windows) when you rotate an object. Holding the Option
key (Macintosh) or Control key (Windows) rotates the container, but not the contained
objects.

Color Palette Button

The Color Palette Button allows new colors to be selected, created and assigned to
objects. Colors can be applied to translucent as well as opaque objects and surfaces.



Design Center (Windows) Color Selector

Changing the color of an existing object

• Select the object and click the Color Palette Button to open the color
selector and pick the required color for the object

Each time that you select a new color, the color appears as a small square across the
top of the Color Selector. This section of the Color Selector is the Color Palette. If you
have selected several colors since you started the program, each of those colors will
be displayed as a small square in the Color Palette. This helps you keep color
selections consistent. By recording the last 30 colors that you selected, the Color
Palette allows you to select the same shade of color for the same types of objects. For
example, you might select a light shade of blue from the Color Selector and apply that
color to a glass window. Every time that you create another glass window, you will
be able to give it exactly the same shade of blue by selecting from the Color Palette,
rather than from the Color Selector.

If the colors in the Color Selector do not contain the desired color, click the mouse
to the icon in the upper left corner of the Color Selector. This displays the standard
Macintosh Color Wheel or Windows Color Selector.

Selecting a new color from the Macintosh Color Wheel or Windows Color
Selector

• Point to a shade of color in the Color Wheel/Selector and click. On the
right of the Color Wheel/Selector dialog is a brightness control. You
may slide the brightness control up or down to change the shade of a
color, thus creating a custom color. (See your system documentation for
more about working with your system and color.)

Windows Color Selector



Macintosh Color Selector

Selecting an Object Surface

Before editing an object surface, you must select it. Like an object, a selected object
surface displays handles at its vertices. You may select an object in the Design View
or in the Walk View.

Selecting an object surface in the Design View

• Click on the Surface Editor Tool, then click on the surface that you wish
to select. You may select a surface that is shown in your view or you may
select a line representing a surface that is perpendicular to your view.

Selecting an object surface in the Walk View

• Click on the 3-D Select Surface button, then point to the 3-D surface in
the Walk View and click.

A selected surface in the Surface Editor



A selected surface is displayed in the Design View and is aligned flat on your view.
When the surface is displayed, you will notice that the title bar of the window has
changed and the Tool Bar has also changed. This set of tools and window is called the
Surface Editor.

Surface Editor

The Surface Editor appears in the Design View when a surface is selected and it allows you
to edit the selected surface. Many of the tools in the Tool Bar for the Surface Editor are the same
as those available in the Design View. The tools exclusive to the Surface Editor are:

Placement Buttons

O is the outside surface, I is the inside surface, B is both the inside and the outside
surfaces. The selected button determines where the color, texture or surface feature
is applied to the surface.

Return Button

The Return Button closes the Surface Editor and returns you to the Design View.

Surface Galleries

When the Surface Editor is open, the Gallery Window changes to show a collection
of 2-D surface features. A surface feature, like an object, can be dragged from the
Gallery and dropped into the Surface Editor on a selected surface. Once dropped, a
surface feature can be rotated with the Rotate Object Tool and scaled with the Resize
Object Tool. Surface feature color can be changed with the Color Bar and textures
can be applied with the Texture Bar.

To edit the opacity of an object's surface, drag the desired shape and opacity (opaque,
translucent or transparent) from the 2-D Surface Gallery to the Surface Editor

window.



The Menus

File Menu

Many of the Design It! File menu options and commands are standard for the
Macintosh and Windows operating systems. These include New, Open, Close, Save,
Save As, Revert to Save, Page Setup/Print Setup, Print, Snapshot and Quit/Exit. This
is a brief description of these menu options.

The File Menu

New

New creates and opens a new Design It! file.

Open...

Open displays the standard Macintosh and Windows Open dialog from which you can
select an existing file to open.

Close

Close closes the current file. If you made any changes to the file since the last time you
saved it, you will be prompted to save the changes before the file is closed.



Save

Save saves the current file under the currently used name.

Save As...

Save As opens the Macintosh and Windows Save dialog, which allows you to save the
current file under a new name.

The Save As Dialog box

Revert to Saved

Revert To Saved opens the last saved version of the current file. If you select this option,
any changes made to the model since the last time that you saved it will be lost unless
you first use Save As.. and save the changes to the file under another name.

Page Setup...

Page Setup/Print Setup opens the standard dialog with which you choose printout size,
paper orientation and other printing features.

Print..

The Print command generates a hard copy of  the active window centered on the page
and enlarged within the constraints of the page.

NOTE: Only what you see on the screen will print.



Printing an entire Design View

• Select the Design View to make it active, zoom out until you can see all
the objects (you may also resize the window), then choose Print.

Printing the Walk View

• Navigate in the Walk View to the desired viewing angle, then choose
Print.

Default Color Print Mode

When printing the Walk View, if your printer does not print grayscale, you may wish
to print black object frames with white shading. This gives you a clean, black-line
drawing.

Printing objects with black frames and white fill

• In the Preferences dialog, click B & W Print Mode.

Black and White Print Mode



Snapshot

Snapshot allows you to save a view of a DesingIt! 3d model in another file format.
The saved view can be a particular perspective in the Walk View, the drawing in a
Design View, the Surface Editor window or a recorded walk path.

The Windows Snapshot Pop-up menu

The Macintosh Snapshot Pop-up menu

Taking a snapshot

• To take a snapshot of either a drawing in the Design View or a particular
perspective in a Walk View select Snapshot from the File menu. Select
BMP... from the pop-up which appears(PICT in Macintosh), this causes
the Save BMP As dialog to appear which enables you to save the view as
a .BMP file.
If you want to make a Snapshot of a recorded walk path choose Animator
Pro... from the Snapshot pop-up(QuickTime for Macintosh). This option
causes the Save Animator Pro As Dialog box to appear which enables
the user to to save the recorded walk path as an Animator Pro file.

Quit (Macintosh) or Exit (Windows)

Qui/Exit exits DesingIt! 3d. If a model is open and changes were made since the last
time it was saved, you will be prompted to save any changes before exiting.

The Edit Menu

Undo

Undo undoes the last operation.

Cut

Cut removes any selected objects and places them in the Clipboard. Cut objects can then
be pasted with the Paste command.The Edit Menu



Copy

Copy copies any selected objects to the Clipboard. The difference between Copy and
Cut is that Copy leaves the original in place, and Cut removes the original. Copied
objects can then be pasted with the Paste command.

Paste

Paste puts the contents of the Clipboard into the model.

Clear (Macintosh) or Delete (Windows)

Clear removes or deletes selected objects, surface features or slices without placing
them in the Clipboard. Selected objects can also be deleted by pressing  Delete or the
Backspace key. The difference between Cut and Delete/Clear is that Delete/Clear
removes objects completely, whereas Cut removes objects to the Clipboard so that they
may be pasted again.

If  you Delete, Cut or Clear something accidently, immediately choose Undo under the
Edit menu after the cutting or clearing operation that you want to reverse.

Duplicate

Duplicate makes an exact copy of any selected object or surface feature and places it
on or near the original. Duplicate does not copy to the Clipboard as does the Copy
command.



Duplicate will duplicate objects as well as object placement, scaling and rotation. For
example, you can create an object, duplicate that object, and position the second object
on the right side of the original so that the objects appear to be touching. Then you can
select Duplicate again and an identical third object, joined on the right side of the second
object, will appear; you’ll have a line of three identical objects spaced the same distance
apart. The duplicate’s position relative to the object that it duplicated is maintained as
long as the original object remains selected. If you continue choosing Duplicate, the
objects will continue duplicating to the right until you have a line of identical objects.
This can be extremely helpful in modeling objects such as staircases.

NOTE: When you create the first duplication, it retains the original object’s position,
scaling and rotation information. The object must remain selected until the next
duplication is made or the information will be lost.

Changes to object type are not duplicated. For example, if you create an object 10 feet
tall and then duplicate it and increase the height of the duplication to 15 feet, subsequent
duplications will have a height of 15 feet, they will not grow in height by increments
of five feet.

The Duplicate command only duplicates manipulations to the entire object. It does not
duplicate edits to part of an object.

Select All

Select All selects all the objects (displays all handles).

Unselect All

Unselect All unselects objects or surface features (handles are not displayed). Another
method of unselecting is clicking on the background in the Design View or Surface
Editor.

Group

Group joins any selected objects so that they are treated as a single object, that is, they
can be moved, rotated or scaled together and selected with a single click. Grouped
objects can be ungrouped with the Ungroup command.

Ungroup

Ungroup ungroups a selected object if it was previously grouped with the Group
command.



Preferences

The Preferences dialog allows you to set preferences for the appearance of Design
Center.

Each time you save a Design Center model, any changes that you made to the
preference settings are saved with it. When you open the model again, its preferences
are restored.

The Preferences Dialog box

Units: Centimeter/Inch

Units determines the units of the ruler in the Design View.

Dithering

Dithering is a technique that allows more colors, which results in more color-accurate
renderings. Dithering is activated by default. The disadvantage of Dithering is that the
screen appears more grainy.

Snap to Grid

Snap to Grid snaps objects to an invisible grid when they are placed or moved.

The grid is based on the ruler tick marks in the Design View and Surface Editor.

If you zoom in or out, the ruler tick marks change, therefore, the invisible grid changes.
For example, if each tick mark represents one inch, handles snap to the nearest inch. If
each tick mark represents one foot, handles snap to the nearest foot.

If Snap to Grid is not selected, the ability to place and move objects is constrained only
by screen pixels.



Snap to Grid also affects object rotation. If Snap to Grid is selected and you rotate an
object, the rotation snaps to 5° increments.

B&W Print Mode

B&W Print Mode prints objects with black lines and white surfaces. The printed result
is a clean, black-line drawing.

B&W Print mode

Flash Graphics (Windows only)

Flash Graphics turns on Design Center’s drawing routines and uses those routines
instead of the standard Microsoft Windows drawing routines. Flash Graphics substantially
speeds up the Design Center application. Usually, Flash Graphics is turned ON by
default; however, some video boards are not compatible with Flash Graphics. The
Design Center  application checks for compatibility with your system when you install,
and if a conflict is detected, Flash Graphics is turned OFF.

Save As Default

Save As Default saves the current preferences as the application default preferences.
Application default preferences apply to all new models that you create. If you open an
existing file, that file’s preferences will override the application defaults.

Get Defaults

Get Defaults resets the Preferences dialog to the original preferences settings.



Cancel

Cancel voids changes that you made to the preferences settings.

OK

OK applies any Preferences dialog changes to the current model.

The Walk Menu

The Walk menu

Level Observer

Level Observer orients the line of sight in the Walk View, making it level if it has been
altered with Shift during navigation.



Wide Angle

Wide Angle changes the Walk View to give the effect of looking through a 15mm,
wide-angle camera lens.

Wide Angle View

Standard

Standard displays the Walk View normally (35mm), that is, not wide angle or telephoto.

The Standard View



Telephoto

Telephoto changes the Walk View to give the effect of looking through a 135mm,
telephoto camera lens.

The Telephoto View

Normal

Normal displays all translucent and transparent object surfaces and surface features,
and displays object color fill, wire frames and textures.

Wireframe

Wireframe speeds up your navigation by displaying only wire frames of objects. No
object color fill, surface features or textures are displayed.

Wireframe selected



Stop

Stop allows you to stop the recording of a walk path. If a walk path is playing, you can
stop it by clicking the mouse button. Once the playback is stopped, selecting Stop will
rewind the recording to its starting point. If you select Play without first rewinding with
the Stop command, the playback will continue from the point where it was stopped.

Play

Play allows you to play back a recorded walk path. Walk paths are recorded with the
Record option.

Record

Record allows you to record a walk path. When you select Record, any movements that
you make in the Walk View are recorded. You can then play back the recorded walk
path or save it with the Snapshot option.

Sky Color

Sky Color allows you to change the background color of the Walk View. Selecting Sky
Color displays the Macintosh Color Wheel or Windows Color Selector so that you can
choose a new color.

The Windows Menu

The Windows menu contains commands for switching between different views in
DesingIt! 3d.

The Window Menu

Design

Design displays the Design View.



Walk

Walk displays the Walk View.

Toggle Windows

Toggle Windows switches between the Design and Walk views.



Buttons and Keyboard Shortcuts

Windows Function Macintosh

Ctrl+A Select All Cmd+A

Ctrl+C Copy Cmd+C

Ctrl+D Duplicate Cmd+D

Ctrl+N New Cmd+N

Ctrl+L Level Observer Cmd+L

Ctrl+O Open Cmd+O

Ctrl+P Print Cmd+P

Ctrl+G Group Cmd+G

Ctrl+T Toggle Windows Cmd+T

Alt + F4 Quit Cmd+Q

Ctrl+S Save Cmd+S

Ctrl+V Paste Cmd+V

Ctrl+X Cut Cmd+X

Ctrl+W Close Cmd+W

Ctrl+Z Undo Cmd+Z

Del Delete Del



Techniques

To create a Virtual World:

From the Galleries Window, scroll and select an item. Then drag and drop the item
in the Design View.

To walk around in a Virtual World:

Use the Navigation Buttons at the top of the Walk View or use Normal or Advanced
Mode Navigation Techniques shown on the following pages.

To change the color of an object:

Select an Object with the Select Object Tool in the Design View. Then select the Color
Bar, press down and drag across to find a new color.



SOFTKEY LICENSE AGREEMENT

PLEASE READ THE FOLLOWING TERMS CAREFULLY BEFORE USING
THIS PROGRAM.

This Agreement governs your use of the SoftKey products enclosed with it including
any manuals, disks, computer program and materials associated with it (the “Software”).
BY OPENING THE SEALED PACKAGES CONTAINING THE DISKS AND/OR
BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS
OF THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, PROMPTLY RETURN THE UNOPENED DISK PACKAGES TO
THE PLACE YOU OBTAINED THEM FOR A FULL REFUND.

1.  Grant of License.  This Agreement permits you to use one copy of the Software,
which is licensed as a single product.  The Software is “in use” on a computer when it
is loaded into the temporary memory (i.e., RAM) or installed into the permanent
memory (e.g., hard disk or other storage device) of that computer.  You may use the
Software on a network provided you have purchased one copy for each user.

2.  Copyright and Restrictions.  The Software is owned by SoftKey or its suppliers
and is protected by United States and Canadian copyright laws and international treaty
provisions.  SoftKey retains all rights not expressly granted.  You must treat the
Software like any other copyrighted material, except that you may either make one
copy of the Software solely for backup or archival purposes or transfer the Software
to a single hard disk provided you keep the original solely for backup or archival
purposes.  You may not rent or lease the Software, but you may transfer your rights
under this Agreement on a permanent basis provided you transfer the license granted
by this Agreement, the Software and all associated printed materials, retain no copies
and the recipient agrees to the terms of this Agreement.  You may not reverse
engineer, decompile or disassemble the Software, except to the extent the foregoing
restriction is expressly prohibited by applicable law.

3.  Limited Warranty.  For 90 days from your date of purchase, SoftKey warrants
that the media on which the Software is distributed are free from defects in materials
and workmanship.  SoftKey will, at its option, refund the amount you paid for the
Software or repair or replace the Software provided that (a) the defective Software
is returned to SoftKey or an authorized dealer within 90 days from the date of purchase
and (b) you have completed and returned the enclosed registration card.  These are
your sole remedies for any breach of warranty.  SoftKey disclaims all other
warranties, either express or implied, with respect to the Software and the
accompanying written materials, including but not limited to implied warranties
of merchantability and fitness for a particular purpose.

4.  Limitation of Liabilities.   In no event will SoftKey be liable for any indirect,
special, incidental, economic or consequential damages arising out of the use or



inability to use the Software, even if SoftKey has been advised of the possibility of
such damages.  In no event will SoftKey’s liability exceed the amount paid by you
for the Software.  Because some jurisdictions do not allow the exclusion or limitation
of liability for consequential or incidental damages, the above limitation may not
apply to you.

5.  U.S. Government Restricted Rights.  The Software is are provided with
RESTRICTED RIGHTS.  Use, duplication or disclosure by the Government is subject
to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and
Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2)
of the Commercial Computer Software—Restricted Rights at 48 CFR 52.227 - 19, as
applicable.  Manufacturer is SoftKey International Inc., 201 Broadway, Cambridge,
MA  02139

©1995 SoftKey Multimedia Inc., a subsidiary of SoftKey International Inc., and
©1995 Virtus Corporation. All rights reserved. SoftKey is a registered trademark and
DesingIt! 3d is a trademark of SoftKey Multimedia Inc. Windows is a trademark of
Microsoft Corporation. Pentium is a trademark and Intel Inside is a registered
trademark of Intel Corporation. All other trademarks are the trademarks of their
respective companies. Architectural Design and Model: designed and used with
permission of House + House Architects, San Francisco, CA


	Title Page
	Installation
	Introduction
	Contacting Technical Support
	Overview
	Document Windows
	Gallery Window
	Design View
	Walk View
	Message Bar
	Memory Indicator
	Active Window
	Toolbar
	View Selector buttons
	Surface Editor Tool
	Select Object tool
	Magnify tool
	Zoom Out tool
	Resize Object tool
	Change View button
	Rotate Object tool
	Color Palette button

	3-D Movement
	Navigation buttons
	Walk Mode buttons
	3-D Surface Selector button
	3-D Object Selector button
	Record and Playback buttons
	Observer

	Design Concepts
	Containment
	Auto Connection
	Placement Depth


	Creating 3-D Models
	Opening a new file
	Selecting New galleries
	Selecting a Gallery Object
	Drag and Drop
	Modifying an Object
	Select Object Tool
	Reshaping an object
	Resize Object tool
	Rotate Object tool
	Color Palette button
	Selecting an Object Surface
	Surface Editor
	Placement buttons
	Return Button
	Surface Galleries

	The Menus
	The File menu
	New
	Open
	Close
	Save
	Save As
	Revert To Saved
	Page Setup
	Print
	Snapshot
	Quit / Exit

	The Edit menu
	Undo
	Cut
	Copy
	Paste
	Clear / Delete
	Duplicate
	Select All
	Unselect All
	Group
	Ungroup
	Preferences

	The Walk menu
	Level Observer
	Wide Angle
	Standard
	Telephoto
	Normal
	Wireframe
	Stop
	Play
	Record
	Sky Color

	The Windows menu
	Design
	Walk
	Toggle windows


	Techniques
	License Agreement
	Buttons and Keyboard Shortcuts

